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Chapter 11

Production and Transport Overviews

This chapterIn this chapter you will build two end-user pages that display the solution cor-
responding to a single ‘roll’ in the rolling horizon process. The first page, the
Production Overview page, concentrates on the optimal production and main-
tenance schedule for every period in the current planning horizon. The second
page, the Transport Overview page, provides not only the optimal transport pat-
terns from the factories to the distribution centers, but also the corresponding
stock overviews for all locations considered.

11.1 Extending the model tree

Needing
additional
identifiers

Whenever you build a professional user interface, it is quite natural to intro-
duce additional identifiers to support such an interface. For instance, an ele-
ment parameter defined over the predefined set of AllColors can be used to
change the color of numbers when they drop below a particular threshhold
value. Another possibility is the introduction of parameters to control the
scrolling mechanism of a Gantt chart. Yet another option is an identifier to
control whether or not a particular object appears at all depending on data
elsewhere in your application.

Introducing
extra model
sections

You should now introduce five extra sections in your model tree corresponding
to the five end-user overview pages already introduced in the Page Manager.
All new page-specific identifiers introduced can then be inserted into the ap-
propriate section. The updated tree structure is shown in Figure 11.1.
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Figure 11.1: Subdividing the The User Interface section

11.2 The Production Overview page

Viewing the
entire page

In this section you will construct the entire page as shown in Figure 11.2. Each
page object will be treated in a separate subsection.

Figure 11.2: The completed Production Overview page
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11.2.1 Execution buttons

The Run Next
button

The first execution button you will add is designed to execute a single step in
the rolling horizon process. This allows you to track the behavior of the model
step by step. To create the Run Next button you should perform the following
actions:

� open the Production Overview page in Edit mode,
� press the New Button button on the toolbar,
� drag and create a small rectangle in the upper right corner of the page,
� specify ”Run Next” (with the quotes) in the ‘Title’ edit field,
� press the Actions tab,
� select the ‘Run’ action,
� press the Add button,
� select the ‘Procedure’ option (not the ‘Page Procedure’ option),
� use the Wizard button to select the procedure RollHorizonOnce,
� press the Finish button, and
� press the OK button.

The Run All
button

The second execution button to be added is designed to execute the entire
rolling horizon process from the current point forward. Just repeat the steps
in the previous paragraph while creating the the Run All button, but select the
procedure RollHorizonToEnd.

The Restart
button

The third execution button is the Restart button which activates the proce-
dure MovePlanningIntervalToStartOfCalendar. Following the execution of this
procedure you can use either of the previous two execution buttons to execute
part or all of the rolling horizon process. Instead of creating the button from
scratch, as in the previous two paragraphs, you could use the ‘copy and paste’
facility as described in the following steps:

� in Edit mode, select the Run All button by clicking on it,
� press the Copy button on the toolbar,
� press the Paste button on the toolbar (the mouse cursor will change

as shown in Figure 11.3) ,
� use the mouse cursor to position the new button underneath the Run All

button,
� click the left-mouse button to confirm the position of the new button,
� double-click the left-mouse button to open the Button Properties dialog

box of the new button, and
� modify the button properties as appropriate.
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Figure 11.3: The mouse cursor after having pressed the Paste button

11.2.2 The production lines table

Three identifiers
in one table

In the first table on the Production Overview page you will include three identi-
fiers, namely:

� the actual production level by factory, production line and time period,
� the number of working days in each week, and
� the current deterioration level associated with each production line.

Actual
production level

The actual level of production will be equal to potential production whenever a
production line is in use. Create a new declaration section Production Overview
Declaration in the Production Overview section, and insert the following param-
eter declaration:

PARAMETER:
identifier : ActualProduction
index domain : (f,p,t)
unit : hl
definition : PotentialProduction(f,p,t) * ProductionLineInUse(f,p,t)

Creating a tableThe first part of the table can be created by executing the following steps:

� ensure that the Production Overview page is in Edit mode,
� press the New Table button on the toolbar,
� drag and create a rectangle that matches the desired table size on your

page,
� in the Identifier wizard select the parameter ActualProduction(f,p,t),
� press the Next button, and
� press the Finish button.

Adding an
identifier

To add the identifier DeteriorationLevel(f,p) as the first column of this new
table you should perform the following actions:

� select the existing table object,
� press the Properties button on the toolbar,
� select the Contents tab,
� press the Add button,
� select the identifier DeteriorationLevel(f,p) using the Identifier wizard,
� press the Next button,
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� uncheck the ‘Automatic split row/column’ checkbox,
� select the ’split line’ entry that pops up in the listbox (see Figure 11.4),
� press the Down button,
� press the Finish button,
� press the Up button to display the identifier DeteriorationLevel as the

first column, and
� press the OK button.

Figure 11.4: Specifying the row and column domain

Moving the split
line

If you had not moved the split line, Aimms would have used the index f for
rows and the index p for columns. However, by moving the split line, both
indices can be used as row indices conforming to Figure 11.5.

Adding another
identifier

Following the routine specified above, you should now add the identifier Actu-
alNumberOfDaysInPeriod(t) as a new row in the table. The table on your screen
should then look like the one shown in Figure 11.5.
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Figure 11.5: The initial production overview table

Creating week
labels . . .

The ‘period’ references in the table are somewhat abstract and not meaning-
ful. In Aimms you can change these references using a string parameter. You
should first create this string parameter in the section Production Overview
Declarations.

STRING PARAMETER:
identifier : PeriodDescription
index domain : (t in Periods)
definition : if ( t in Periods.past) then

"past"
elseif ( t in Periods.beyond ) then

"beyond"
else

FormatString("%e",WeekInPeriod(t))
endif

The predefined function FormatString allows you to compose a string that is
built up from a combination of numbers, strings and set elements (see Chap-
ter 5 of The Language Reference).

. . . as part of
the table

The above string parameter PeriodDescription(t) can be used as element text
in the table after executing the following steps:

� open the Table Properties dialog box of the table,
� select the Element Text tab (see Figure 11.6),
� select the index t,
� press the Modify button,
� select the identifier PeriodDescription(t),
� press the Next button,
� press the Finish button, and
� press the OK button.
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Figure 11.6: The Element Text tab of the Table Properties dialog box

Viewing the
result

If the table does not show the constructed period descriptions, and you receive
an initialization warning, you should press the Run Next button once and the
period descriptions should then appear.

Specifying the
number format
. . .

Aimms chooses a default number format when displaying identifiers in a table.
However, you might want to change the number of digits and/or the number
of decimals. For example, the parameter ActualNumberOfDaysInPeriod should
be an integer, and the values of the parameter ActualProduction are too large
for the default format.

. . . first for
actual
production

You can execute the following steps to change the number format of Actual-
Production to a width of 8 digits with 2 decimals:

� open the Table Properties dialog box of the table,
� select the Format tab (see Figure 11.7),
� select the element ActualProduction(f,p,t) from the drop-down listbox,
� enter the number ‘8’ (without quotes) in the ‘Width’ field,
� enter the number ‘2’ (without quotes) in the ‘Decimals’ field, and
� press the Apply button.
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Figure 11.7: The Format tab of the Table Properties dialog box

. . . and then for
the other two
identifiers

Next, you should change the format of the parameter DeteriorationLevel to a
width of 5 with 2 decimals, and also adjust the number format of the parame-
ter ActualNumberOfDaysInPeriod to a width of 5 with 0 decimals. An instance of
the completed table is shown in Figure 11.8.

Figure 11.8: The completed production line table

11.2.3 The factory production bar chart

Creating a bar
chart

The production lines table displays a production overview for each individual
production line. The following bar chart will provide a similar overview at
the factory level. To create this bar chart you should perform the following
actions:
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� make sure that the Production Overview page is opened in Edit mode,
� press the New Bar Chart button on the toolbar,
� drag and create a rectangle underneath the Production Lines table with

the same width, and
� select the variable Production(f,t) using the Identifier wizard.

Creating week
labels

As before, you should change the abstract period references into week refer-
ences using the string parameter PeriodDescription. The resulting bar chart is
shown in Figure 11.9.

Figure 11.9: The completed factory production bar chart

11.2.4 The vacation table

Creating the
table

The created table will display all the weeks that correspond to a vacation pe-
riod with a 40% drop in production. To create this table you should complete
the following sequence of steps:

� make sure that the Production Overview page is in Edit mode,
� press the New Table button on the toolbar,
� drag and create a rectangle below the factory production bar chart with

the same dimensions,
� select the parameter IsVacationPeriod(f,t) using the Identifier wizard,

and
� change the element text of the index t to the string parameter PeriodDe-

scription(t).

Displaying
nonzero values
as crosses

The identifier IsVactionPeriod(f,t) is a binary parameter. A value of zero
means ’no vacation period’, while a value of one indicates a ‘vacation period’.
The chosen value of one is somewhat arbitrary, and for this reason you might
prefer to display a cross instead of a one. This minor modification can be
accomplished as follows:

� open the Table Properties dialog box of the table,
� select the Format tab (see Figure 11.10),
� check the ‘0–1 values’ check box, and
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� press the OK button.

Figure 11.10: The Format tab of the Table Properties dialog box

Note that at this point the table is still empty since no vacation weeks have yet
been specified. Later, you will specify these vacation weeks using a Gantt chart
object on the Absentee Overview page.

11.2.5 The horizon-calendar tables

Creating your
first composite
table

In this subsection you will create two composite tables that establish the rela-
tionship between the abstract horizon periods and the weekly and daily calen-
dar periods. Composite tables in Aimms resemble the structure of relational
database tables, and you can adjust the width of columns from within the
graphical interface. To create your first composite table, you should execute
the following steps:

� press the New Composite Table button on the toolbar,
� draw a rectangle on the page,
� select the parameter WeekInPeriod(t),
� press the Next button, and
� press the Finish button.
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Creating the
second table

For the second composite table you should select the indexed set DaysInPe-
riod(t). The two composite tables should look similar to the ones shown in
Figure 11.11.

Figure 11.11: The mapping between horizon and calendars

11.2.6 The maintenance and mode switches tables

Creating the
maintenance
table

As with vacation periods and holidays, maintenance periods also cause a de-
crease in production. Therefore, a maintenance overview can also contribute
to the interpretation of the results in the production line table and factory pro-
duction bar chart. By now you should be able to create the maintenance table
without guidance. This composite table needs only the identifier LineInMainte-
nance(f,p,t) as its domain, and the table will immediately contain the required
three columns. To complete the table you should again change the abstract pe-
riod references by specifying that the string parameter PeriodDescription(t) is
used as the element text of the index t (as you did previously).

Creating the
mode switch
table

The last composite table on the Production Overview page will display all the
optimal mode switches for the current planning horizon. It can be specified
in the same way as the table in the previous paragraph. The identifier Produc-
tionLineLevelChange(f,p,t) is used to specify the domain of the table. The two
composite tables are shown in Figure 11.12.

Figure 11.12: The maintenance (left) and mode switch (right) tables
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11.2.7 The total costs bar chart

Declaring
auxiliary
parameters

The final data object on this page will display the four cost components that
together determine the overall total cost, in an aggregated way. As of yet, there
are no identifiers that contain the values of these four components. Therefore,
you must first declare four new parameters describing the aggregated produc-
tion, transport, stock and mode-switch costs which are to be placed at the end
of the Production Overview section. Note that the aggregated transport and
stock costs are expected costs.

PARAMETER:
identifier : TotalProductionCost
unit : $
definition : sum[ (f,t), UnitProductionCost(f) * Production(f,t) ]

PARAMETER:
identifier : TotalTransportCost
unit : $
definition : sum[ (f,c,t,s), ScenarioProbability(s) * UnitTransportCost(f,c) *

Transport(f,c,t,s) ]
PARAMETER:

identifier : TotalStockCost
unit : $
definition : sum[ (l,t,s), ScenarioProbability(s) * UnitStockCost(l) *

Stock(l,t,s) ]
PARAMETER:

identifier : TotalModeSwitchCost
unit : $
definition : sum[ (f,p,t), FixedCostDueToLevelChange *

ProductionLineLevelChange(f,p,t) ]

Creating a bar
chart

Following the declaration of the above four identifiers, you can now create a
bar chart object with as its first identifier TotalProductionCost. You can then
open the Bar Chart Properties dialog box and use the Contents tab to add the
remaining three identifiers (see Figure 11.13). You can ignore all the initializa-
tion warnings.
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Figure 11.13: The Contents tab of the Bar Chart Properties dialog box

Viewing the
result

The completed total costs bar chart should look like the one shown in Fig-
ure 11.14.

Figure 11.14: The completed total cost bar chart

11.2.8 Completing the page

Changing fontsOne way to display more information within objects on a page is to reduce the
size of the font used. To create a new, small, font for use with all data objects
you should execute the following actions:

� make sure that the Production Overview page is in Edit mode,
� select a table, and then
� select the remaining seven tables and bar charts while keeping the Shift

key pressed,
� press the Properties button on the toolbar,
� select the Font tab, and
� press the Add button,
� enter ‘7’ as the ‘Font Size’ (see Figure 11.15),
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� press the OK button,
� specify ‘Data Font’ as the name of the new font, and
� press the OK button twice.

Figure 11.15: The specification of a new font

Alignment of
objects

Several tables, bar charts and composite tables have been placed on the Pro-
duction Overview page. To complete the page you should first align and resize
the page objects in order to create a structured and attractive composition. For
this purpose Aimms offers several alignment tools that are accessible through
the Alignment submenu of the Edit menu. The following alignment options
are supported:

� aligning objects to the left, right, top or bottom,
� centering objects horizontally or vertically,
� spreading objects horizontally or vertically, and
� making object size equal in width or height.

Aligning the
Production
Overview page

You should now use the alignment tools described in the previous paragraph
to align all the page objects as shown in Figure 11.16. Remember, if you need
to select several objects at once, you should keep the Shift key pressed.
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Figure 11.16: Aligned objects on the Production Overview page

Creating the
text objects

Adding text to objects will help the end-user of your application. In this para-
graph you will create a text object, and in the next paragraph you will change
the font associated with this text. Consider first the production line table in
the upper left corner, and add a line of text by following these steps:

� make sure that the Production Overview page is in Edit mode,
� select the Text command from the Object menu,
� draw a rectangle above the production line table,
� enter ‘Production Lines’ (without quotes) in the edit field (see also Fig-

ure 11.17), and
� press the OK button.

You should now create six more text objects as shown in Figure 11.2 at the
beginning of this chapter.
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Figure 11.17: The Text tab of the Text Properties dialog box

Changing the
text font

To change the font size of the text objects referred to in the previous para-
graph, first select all of them using the Shift key, and create a new font named
‘Title Font’ with ‘Font Size’ 18. Again, you are referred to the text objects as
shown in Figure 11.2.

Creating the
rectangles

To improve the structure of your page even further, you can enclose one or
more page objects within a rectangle. The following steps are required:

� make sure that the Production Overview page is in Edit mode,
� select the Rectangle command from the Object menu, and
� draw the rectangle around an object on your page.

Again, you should try to match the six rectangles as shown in Figure 11.2.

Rectangle line
size

To embolden your rectangles you can enlarge their line thickness by executing
the following actions:

� make sure that the Production Overview page is in Edit mode,
� select all rectangles using the Shift key,
� press the Properties button on the toolbar,
� complete the Rectangle tab of the Rectangle Properties dialog box as

shown in Figure 11.18, and
� press the OK button.
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Figure 11.18: The Rectangle tab of the Rectangle Properties dialog box

Changing the
foreground
color

To change the default foreground color of all objects on the page from black
to navy blue, you need to execute the following steps:

� make sure that the Production Overview page is in Edit mode,
� press the Ctrl-A key combination to select all objects on the page,
� unselect the three execution button using the Shift key,
� press the Properties button on the toolbar,
� select the Colors tab,
� select ‘User’ as the determinant of the ‘Foreground’ color,
� select the color ‘Navy Blue’ from the drop-down list, and
� press the OK button.
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Figure 11.19: The Colors tab of the Properties dialog box

Changing text
inside objects

By default, Aimms will display the identifier names inside data objects. If this
default name needs to be changed for your end-user, you can enter your own
preferred string. You can even enter a string parameter, so that you can serve
end-users with different language needs. As an illustration, please change
the default representation of the identifier ActualNumberOfDaysInPeriod to the
string ‘Number of working days’ by performing the following steps:

� select the production lines table,
� open its Table Properties dialog box,
� select the Text tab,
� select the identifier ActualNumberOfDaysInPeriod(t),
� select ’Other’ from the drop-down list in the ‘Title’ section,
� specify ”Number of working days” (in quotes) as the new title (see Fig-

ure 11.20), and
� press the OK button.
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Figure 11.20: The Text tab of the Table Properties dialog box

Coloring data
entries

In Aimms it is even possible to color the individual data entries in tables. For
instance, you might want to display the deterioration levels in red instead
of blue whenever these levels have reached their maximum. To do this, you
should first create a so-called color parameter. Such a parameter is an element
parameter in the predefined Aimms set AllColors. The contents of this set
can be inspected or changed using the User Colors command from the Tools
menu.

Creating a color
parameter . . .

As an example, please declare the following color parameter in the Production
Overview Declarations section:

ELEMENT PARAMETER:
identifier : DeteriorationColor
index domain : (f,p) | p in FactoryProductionLines(f)
range : AllColors
definition : if ( DeteriorationLevel(f,p) > MaximumDeteriorationLevel(f,p) ) then

’red’
else

’navy blue’
endif

. . . and linking it
to model data

To specify the actual link between the color parameter and the data in the table
you should perform the following actions:

� open the Table Properties dialog box of the production lines table,
� select the Colors tab,
� select the identifier DeteriorationLevel(f,p) in the ‘Identifier’ section (at

the bottom),
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� select ‘Model’ as the color determiner,
� press the Wizard button (see Figure 11.21) to select the identifier De-

teriorationColor(f,p), and
� press the OK button.

Figure 11.21: The Colors tab of the Table properties dialog box

The completed
page

The completed Production Overview page is repeated in Figure 11.22, so that
you can compare it with the contents of your screen.
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Figure 11.22: The completed Production Overview page

11.3 The Transport Overview page

Viewing the
entire page

In this section you will construct the entire Transport Overview page as shown
in Figure 11.23. Each page object is covered by a separate subsection.
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Figure 11.23: The completed Transport Overview page

11.3.1 Scenario selection object

Scenario
dependency

The values of the identifiers Transport and Stock are different for each demand
scenario. Displaying these values for all scenarios on a single page would
overload the page. Therefore, the displayed information will be limited to one
scenario, and the end-user will be able to switch between scenarios. Aimms

provides a selection object for this purpose.

Creating a
scenario
parameter

In the model section Transport Overview you should first create a new declara-
tion section Transport Overview Declarations containing the following element
parameter:

ELEMENT PARAMETER:
identifier : DisplayedScenario
range : Scenarios

Creating a
selection object

The value of this element parameter is then determined by linking it to a se-
lection object through the following steps:

� open the Transport Overview page in Edit mode,
� press the New Selection Object button on the toolbar,
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� drag and create a small rectangle in the upper left corner,
� select ‘Radio Buttons’ from the ‘Single Item Selection’ options,
� select ‘Element Parameter’ as the ‘Type of Data’,
� press the Wizard button next to the ‘Element’ field (see Figure 11.24),
� select the element parameter DisplayedScenario,
� press the Finish button, and
� press the OK button.

Figure 11.24: The New Selection Object dialog box

Using the
selection object

The selection object that you have created is shown in Figure 11.25. Selecting
a radio button in the selection object will set the corresponding value of the
element parameter DisplayedScenario. As you will see later in this section,
other page objects will be defined over this element parameter, and their data
will adjust accordingly.

Figure 11.25: The scenario selection object
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11.3.2 Period selection object

Creating a
period
parameter

As with the element parameter DisplayedScenario, you can introduce another
element parameter to support the selection of a particular period. Please
declare the following element parameter at the end of the section Transport
Overview.

ELEMENT PARAMETER:
identifier : DisplayedPeriod
range : Periods

Creating the
drop down list

When creating the selection object that sets the element parameter Displayed-
Period, you should select the ‘Drop Down List’ option rather than the ‘Radio
Buttons’ option (see Figure 11.26).

Figure 11.26: The New Selection Object dialog box

Specifying
element text

Once you have created the drop down list, you can open its Selection Object
Properties dialog box (either by double-clicking or using the right-mouse pop-
up menu), and change the element text from abstract period references to
specific week references. You can accomplish this change by selecting the
Element Text tab, and specifying the string parameter PeriodDescription(t)
as the element text of the index Periods.
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Initializing
element
parameters

To initialize the two element parameters DisplayedScenario and DisplayedPe-
riod you should temporarily change the page mode to User mode, and use the
two selection objects to select ‘optimistic’ as the displayed scenario and ’week
27, 2000’ as the displayed period.

11.3.3 Transport network object

Copying the
network object

The third object to be created on the transport page is a network object dis-
playing the optimal transports for a given scenario and a given period in the
planning interval. In Chapter ?? you created a network object displaying all
locations and this will be used to create the new network object. To copy the
existing network from the Locations page to the Transport Overview page you
should perform the following steps:

� open both the Locations and the Transport Overview pages in Edit mode,
� select the Locations page tab,
� select the network object on the Locations page,
� press the Copy button on the toolbar,
� close the page by clicking on the cross in the upper right corner,
� select the Transport Overview page tab,
� press the Paste button ,
� position the network object underneath the selection object, and
� press the left-mouse button.

Adding arcs to
the network

The network object that you created in Chapter ?? only showed the locations.
You can now add arcs to the network object to represent the optimal transport
between the factories and the distribution centers for a given period and a
given scenario. To add these arcs, you should take the following actions:

� select the network object in Edit mode,
� open its Network Object Properties dialog box,
� select the Contents tab,
� select the ‘----- Arcs -----’ entry from the listbox,
� press the Add button,
� select the variable Transport(f,c,t,s), and
� press the Next button.

Next you need to specify that the indices t and s will assume the values of the
element parameters DisplayedPeriod and DisplayedScenario respectively:

� select the index t from the list box,
� select the ‘Element Parameter’ radio button,
� select the element parameter DisplayedPeriod from the drop-down list,
� select the index s from the list box,
� select the ‘Element Parameter’ radio button,
� select the element parameter DisplayedScenario from the drop-down list,
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� press the Finish button (see Figure 11.27), and
� press the OK button.

Figure 11.27: Fixing indices of the variable Transport

Specifying arc
thickness

The network object will display arcs for all transport values that have a non-
zero value. To distinguish between small and large transport values the thick-
ness of the arc can be varied depending on the transport value. To achieve this
you should execute the following actions:

� select the network object in Edit mode,
� open its Network Object Properties dialog box,
� select the Arcs tab,
� press the Wizard button to the right of the ‘Size’ field,
� select the identifier Transport(f,c,t,s),
� press the Next button,
� link the index t to the element parameter DisplayedPeriod,
� link the index s to the element parameter DisplayedScenario,
� press the Finish button, and
� press the OK button.
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Figure 11.28: The Arcs tab of the Network Properties dialog box

Viewing the arcsAssuming that you have already solved the model for the first step, the arcs in
the network object should now have different widths as shown in Figure 11.29.

Figure 11.29: Using arc thickness to illustrate transport volumes

Node and arc
dependent
information

Aimms has facilities to display node and arc dependent information whenever
an end-user selects a node or an arc in the network object. Consider, for
instance, Figure 11.23. The data block displayed in the lower right corner
of that page deals with a particular distribution center, while the data block
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displayed in the upper right corner deals with a particular factory. In the
following paragraphs you will specify how the selection of a particular arc will
update both of these data blocks, while the selection of a particular node will
update one of these data blocks.

Declaring
location
identifiers

The following two element parameters will be needed to hold the current
choice of factory and distribution center. Please add their declarations to the
Transport Overview Declarations.

ELEMENT PARAMETER:
identifier : DisplayedFactory
range : Factories

ELEMENT PARAMETER:
identifier : DisplayedCenter
range : Centers

Specifying arc
dependency

Arc dependency can then be specified with the aid of the above two element
parameters. Whenever an arc is selected, the locations of the corresponding
two end nodes should become the current values of DisplayedFactory and Dis-
playedCenter. As soon as their values change, the data blocks in Figure 11.23
will be updated accordingly. To implement this action, you should execute the
following steps:

� select the network object in Edit mode,
� open its Network Object Properties dialog box,
� select the Contents tab,
� select the arc Transport(f,c,DisplayedPeriod,DisplayedScenario),
� press the Modify button,
� press the Next button,
� select the index f from the ‘Index specification’ list box,
� use the drop-down list under ‘Link Index Entry’ to select the element

parameter DisplayedFactory,
� repeat the previous two steps to link the index c the element parameter

DisplayedCenter,
� press the Finish button, and
� press the OK button.

By simply linking an index to an element parameter as shown in Figure 11.30
you have specified the linkage between a selection and a data block. This
powerful facility is also available for other data objects in Aimms.
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Figure 11.30: The Contents tab of the Network Object Properties dialog box

Specifying node
dependency

Specifying node dependency is not as straightforward as with arc dependency,
because a node is a location that can be either a factory or a distribution center.
This makes the linkage between a node and one of the data blocks less trivial to
specify. A straightforward procedure, however, can resolve this choice. Once
you have specified such a procedure, it is then straightforward to link it to the
network object.

The selection
procedure . . .

Create a procedure SelectLocationInNetwork(SelectedLocation), where the ar-
gument SelectedLocation is declared as a local element parameter with Range
attribute Locations and with the Property attribute ‘Input’ as shown in Fig-
ure 11.31. The following conditional statement will constitute the Body at-
tribute of this procedure:

if ( SelectedLocation in Factories )
then DisplayedFactory := SelectedLocation ;
else DisplayedCenter := SelectedLocation ;

endif;



Chapter 11. Production and Transport Overviews 147

Figure 11.31: The contents of the Transport Overview section

. . . linked to the
network object

The above procedure will be linked to the network object as a procedure upon
selection by executing the following steps:

� select the network object in Edit mode,
� open its Network Properties dialog box,
� select the Procedure tab,
� verify that ‘Node: l’ is selected as the ‘Identifier’,
� select the procedure SelectLocationInNetwork as the ‘Upon Selection’ pro-

cedure,
� press the Next button,
� select the ‘Index’ radio button,
� select the index l from the ‘Index’ drop-down list (see Figure 11.32),
� press the Finish key, and
� press the OK button.
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Figure 11.32: The Procedure tab of Network Object Properties dialog box

Increasing the
node size

In order to see nodes in the network more clearly, you can increase their size
by changing the Nodes tab of the network object as shown in Figure 11.33. If
you want, you can also change their color using the Colors tab.

Figure 11.33: The Nodes tab of the Network Object Properties dialog box
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Viewing the
result

Once you have increased the node size, the network object should look like the
one shown in Figure 11.34. If you had used separate node sets for factories
and centers, different icons could have been used to represent them in the
network object.

Figure 11.34: The network object with increased node size

11.3.4 Factory text object

Factory
description

The upper right data block in the Transport Overview page contains data per-
taining to a particular factory. The name of that factory is displayed at the top
of this block using a text object. The following string parameter is needed to
fill this object:

STRING PARAMETER:
identifier : FactoryDescription
definition : FormatString( "%e", DisplayedFactory )

You should add this declaration at the end of the Transport Overview Declara-
tions section.
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Creating a text
object

You should now create a text object that will display the contents of the string
parameter you have just declared. Try to create the text object on your own.
To display the string parameter FactoryDescription you should complete the
Text tab of the Text Properties dialog box as shown in Figure 11.35. You can
also try changing its color and font size.

Figure 11.35: The Text tab of the Text Properties dialog box

11.3.5 The factory production bar chart

Creating the
bar chart

You will begin by creating a bar chart containing the production data corre-
sponding to the currently selected factory. The name of this factory is the
value of the element parameter DisplayedFactory. You should execute the fol-
lowing steps:

� make sure the Transport Overview page is opened in Edit mode,
� press the New Bar Chart button on the toolbar,
� drag a rectangle underneath the factory description text object,
� select the variable Production(f,t) in the Identifier wizard,
� press the Next button,
� link the index f to the element parameter DisplayedFactory, and
� press the Finish button.

Adjusting the
element text

The period references along the x-axis are probably too long to fit. The Period-
Description parameter contains even longer strings. To create short references
you should now create the following string parameter:
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STRING PARAMETER:
identifier : ShortPeriodDescription
index domain : t
definition :

if ( WeekInPeriod(t) )
then FormatString( "%n", TimeslotCharacteristic( WeekInPeriod(t), ’week’ ) )
else ""

endif

You should change the element description of the period index t to be the
string parameter ShortPeriodDescription using the Element text tab of the Bar
Chart Properties dialog box.

The page so farAt this point, the page on your screen should resemble the partially completed
Transport Overview page shown in Figure 11.36.

Figure 11.36: The current Transport Overview page

11.3.6 The factory stock bar chart

Copying the
previous bar
chart

To create a bar chart containing the stock values for the currently selected
factory, you can make use of the following copy, paste and adjust actions:

� select the production bar chart you have just created,
� press the Copy button on the toolbar,
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� press the Paste button on the toolbar,
� position and drop the new bar chart underneath the production bar

chart,
� press the Properties button on the toolbar,
� select the Contents tab,
� select the identifier Production(DisplayedFactory,t) from the listbox,
� press the Modify button,
� select the identifier Stock(l,t,s),
� press the Next button,
� link the index l to the element parameter DisplayedFactory,
� link the index s to the element parameter DisplayedScenario,
� press the Finish button, and
� press the OK button.

11.3.7 Factory transport composite table

Specifying the
table . . .

The network object only displays transport values for the selected period. To
view the transport values for all periods in the planning interval you can create
a composite table by executing the following steps:

� press the New Composite Table button on the toolbar,
� draw a rectangle on the page,
� select the variable Transport(f,c,t,s),
� press the Next button,
� link the index f to the element parameter DisplayedFactory,
� link the index s to the element parameter DisplayedScenario,
� press the Finish button,

. . . and
improving its
appearance

You can improve the overall appearance of the table by taking the following
actions:

� specify the string parameter PeriodDescription(t) as the element text of
the index t, and

� change the font to the ‘Data Font’ that you specified in Subsection 11.2.8.

The resulting table should now look like the one shown in Figure 11.37.

Figure 11.37: The factory transport composite table
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11.3.8 Factory properties scalar object

To be able to view the minimum and maximum stock levels as well as the
maximum transport capacity for the selected factory, you should first create a
scalar object with the first of these identifiers:

� create a scalar object,
� select the identifier MinimumStock(l), and
� link its index l to the element parameter DisplayedFactory.

Next, you should add the remaining two identifiers to the scalar object by
performing the following actions:

� open the Properties dialog box,
� select the Contents tab,
� press the Add button,
� select the identifier MaximumStock(l),
� press the Next button,
� link the index l to the element parameter DisplayedFactory,
� press the Finish button,
� press the Add button,
� select the identifier MaximumTransportCapacity(f),
� press the Next button,
� link the index f to the element parameter DisplayedFactory,
� press the Finish button, and
� press the Apply button.

Identifier MinimumStock(l) and MaximumStock(l) have different unit from Max-
imumTransportCapacity(f). The unit of each identifier will be shown by the
following steps:

� select the Units tab of the Properties dialog box,
� it shows the setting of the first identifier MinimumStock(DisplayedCenter),
� select the Show per Value radio button under Display as Figure 11.38,
� click the drop down list on top of the dialog,
� select the second identifier MaximumStock(DisplayedCenter),
� again, select the Show per Value radio button under Display,
� repeat this for MaximumTransportCapacity(DisplayedCenter) as well, and
� press the OK button.
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Figure 11.38: The Property dialog of factory scalar object

The resulting table should look like the one shown in Figure 11.39 including
the appropriate values.

Figure 11.39: The factory scalar object containing factory limitations

11.3.9 Factory production line table

Copying the
production line
table

The factory production line table is essentially the same as the production
line table on the Production Overview page with the exception that the index
f is replaced by the element parameter DisplayedFactory. The following steps
involve copying the table from one page to the next:

� open both the Production Overview and the Transport Overview page in
Edit mode,

� select the Production Overview page tab,
� select the production line table,
� press the Copy button on the toolbar,
� close the page,
� select the Transport Overview page tab,
� press the Paste button ,
� position the object underneath the other factory information objects,

and
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� press the left-mouse button.

Changing table
properties

The following changes are required to display only the information for the
currently selected factory:

� open the Properties dialog box of the new table,
� select the Contents tab,
� select the DeteriorationLevel(f,p) entry in the list,
� press the Modify button,
� press the Next button,
� link the index f to the element parameter DisplayedFactory and close the

wizard,
� select the ActualProduction(f,p,t) entry in the list,
� press the Modify button,
� press the Next button,
� link the index f to the element parameter DisplayedFactory and close the

wizard,
� select the ActualNumberOfDaysInPeriod(t) entry from the list,
� press the Delete button, and
� press the Apply button.

An error dialog will appear due to the fact that on the Colors tab there is still
reference to the index f. By pressing the Ok on the dialog window, Aimms

will get rid of the index reference (i.e. removing the DeteriorationColor(f,p)).
Therefore, you have to specify color for the DeteriorationLevel(f,p) again and
change the index reference. This can done by executing the following steps:

� select the Colors tab,
� in the ‘Identifier’ section select ‘Model’ as the color determiner,
� press the Wizard button again to select the identifier Deterioration-

Color(f,p)
� link the index f to the element parameter DisplayedFactory,
� press the Finish button, and
� press the OK button.

The resulting table is shown in Figure 11.40.

Figure 11.40: The factory production line table
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Arranging the
factory objects

At this stage you should use the aligning and resizing facilities that were dis-
cussed in Subsection 11.2.8 to rearrange the composition objects as shown in
Figure11.41. Once the factory data block is neatly organized, you can copy it
in its entirety to create a similar data block for distribution centers.

Figure 11.41: The factory data block

11.3.10 The distribution center data block

To create the four page objects for a particular distribution center you should
execute the following steps:

� select all objects in the factory data block except for the production lines
table at the bottom using the Shift key,

� press the Copy button on the toolbar,
� press the Paste button on the toolbar,
� position the five objects underneath the factory information area (see

Figure 11.42), and
� press the left-mouse button.



Chapter 11. Production and Transport Overviews 157

Figure 11.42: The copy and paste process illustrated

Making the
required
modifications

By now you should have enough experience to make a series of modifications
to transform the factory data block into a distribution center data block. First
add the following declaration at the end of the Transport Overview Declara-
tions section.

STRING PARAMETER:
identifier : CenterDescription
definition : FormatString( "%e", DisplayedCenter )

The following list of actions now needs to be executed, using the detailed
knowledge gained so far:

� change the string parameter FactoryDescription to the string parameter
CenterDescription using the Text tab of the Text Properties dialog box
of the copy of the text object,

� remove MaximumTransportCapacity(DisplayedFactory) from the Contents
tab of the scalar object,

� find Production(DisplayedFactory,t) on the Contents tab of the produc-
tion bar chart,

� change this to Demand(DisplayedCenter,t,DisplayedScenario),
� find Transport(DisplayedFactory,c,DisplayedPeriod,DisplayedScenario)

on the Contents tab of the factory transport composite table,
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� change this to Transport(f,DisplayedCenter,DisplayedPeriod,Displayed-
Scenario),

� open, in sequence, the Contents tab of the Properties dialog box associ-
ated with the table, the scalar object and the two bar charts, and

� replace all references to the element parameter DisplayedFactory with
one to the element parameter DisplayedCenter.

11.3.11 Completing the page

Copying the
execution
buttons

At this point you should copy the three execution buttons (Run Next, Run All
and Restart) from the Production Overview page, and paste them at the same
position on the Transport Overview page. You could introduce a new template
page for this purpose.

Beautifying the
page

Finally, you could enhance the page by adding rectangles, changing text color
and sizes as discussed in Subsection 11.2.8. Figure 11.43 will serve as a guide
while completing the Transport Overview page on your screen.

Figure 11.43: The completed Transport Overview page
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